
Money Smith Index
Money Smith Manual:

Introduction to Money Smith Introduction to the basics.
Setting up Money Smith How to load, enter, and exit Money Smith.
Money Smith files How to open, close and backup Money Smith files.
Setting up your accounts Establishing and editing your accounts.
Entering Transactions Entering and editing transactions.
Money Smith reports Creating and printing reports.
Money Smith graphs Creating and printing graphs.
Printing Basics Printing Checks, Graphs, Reports, and Views.
Recurring Transactions Automate your regular bills.
Setting up Categories Setting up account categories.
Investment accounts Handle stocks, mututal funds, and the like.
Ending the Year Rolling out transactions at the end of the year.

Keyboard Help:
Keyboard Help Display help on keys.

Commands:
System Commands System menu box commands.
File Commands File menu commands.
Edit Commands Edit menu commands.
View Commands View menu commands.
Options Commands Options menu commands.
Reports Commands Reports menu commands.
Graphs Commands Graphs menu commands.
Window Commands Window menu commands.
Help Commands Help menu commands.

Dialogs:
Account Editing Dialog Account editing dialog.
Transaction Editing Dialog Transaction editing dialog.
Investment Editing Dialog Investment editing dialog.

License:
License Terms Licensing terms for Money Smith.



Command Index
Commands:

System Commands System menu box commands.
File Commands File menu commands.
Edit Commands Edit menu commands.
View Commands View menu commands.
Options Commands Options menu commands.
Reports Commands Reports menu commands.
Graphs Commands Graphs menu commands.
Window Commands Window menu commands.
Help Commands Help menu commands.

Commands under the System menu box:
System Restore command Restore window to previous size.
System Move command Move window.
System Size command Change the size of a window.
System Minimize command Shrink window to an icon.
System Maximize command Size window to full screen.
System Close command Close window.
System Switch To command Switch to another task.
System Next command Switch to next document.
System Scrollbar Scroll the window vertically or horizontally.

Commands under the File menu:
File New command Create a new file.
File Open command Open and existing file.
File Close commandClose an open window or file.
File Save command Save current file.
File Save As command Save active window to a new file name
File Delete command Delete a file.
File Print command Set up printer.
File Printer Setup command Set up printer.
File Exit command Exit Money Smith.
File 1, 2, 3 command Directly open a previously used file.

Commands under the Edit menu:
Edit Cut command Cut an account or transaction to clipboard.
Edit Copy command Copy an account or transaction to clipboard.
Edit Paste command Paste an account or transaction from clipboard.
Edit Add command Add a new account or transaction.
Edit Edit command Edit the current account or transaction.
Edit Delete command Delete the current account or transaction.

Commands under the View menu:
View Account command View account list.
View Transaction command View current transactions.
View Register command View current account's transactions.
View Toolbar command Toggle Toolbar on and off.
View Statusbar command Toggle Statusbar on and off.
View Grid command Toggle grid lines on and off.
View Date command Change the currently viewable date.

Commands under the Options menu:
Options Recurring Transactions command Edit recurring transactions.



Options Category command Edit category list.
Options Investments command Edit investment accounts.
Options End of Year command Perform end of year processing.
Options Password command Set or reset password for account.
Options Report Title command Set the title for graphs and reports.

Commands under the Report menu:
Report Balance Statement command Create a balance report window.
Report Income Statement command Create an income report window.
Report Budget Report command Create a budget report window.
Report Tax Summary command Create a tax summary report window.
Report Reconcile Current Account command Create a reconciliation report.
Report Category command Create a balance report window.
Report Investment Summary command Create an investment summary window.

Commands under the Graph menu:
Graph Assets command Graph current assets.
Graph Liabilities command Graph current liabilities.
Graph Equity command Graph current equity.
Graph Income command Graph current income.
Graph Expense command Graph current expenses.
Graph Category command Graph a single category.
Graph Current Investment command Graph the current account's investment info.

Commands under the Window menu:
Window Tile command Tile windows in workspace.
Window Cascade command Cascade windows in workspace.
Window Arrange Icons command Arrange Icons in workspace.
Window Close All command Close all windows in workspace.
Window 1,2,3... command Activate a window.



Keyboard Help
Money Smith Window Keys

F1: Brings up Help Index
Shift+F1: Activates Money Smith point and shoot help
Up, Down Arrows: Move current transaction/account bar up or down.
PageUp, PageDown: Page display forward or back one screen.
Home, End: Skip to beginning or end of current display.
Enter: Edits the current account or transaction.
Delete: Deletes the current account or transaction.
Insert: Inserts a new account or transaction into the list.
F10: Moves cursor to the menu.

Dialog Keys
Tab: Moves cursor to next field.
Backtab: Moves cursor to previous dialog field.
Space: Select or deselect a pushbox or buitton.
Enter: Activates button with heavy outline - usually saving the current dialog.
Arrow Keys: Move cursor within a text field.
Alt+space: Activate system menu box in upper right corner.

Cut & Paste Keys:
Ctrl+Ins: Copy the current account or transaction to the clipboard.
Shift+Delete: Cut the current account or transaction to the clipboard.
Shift+Ins: Paste an account or transaction from the clipboard.

Function Keys
F1: Activates Money Smith Help Index
F3: Save currently active Money Smith file.
F4: Tile windows in workspace.
F5: Cascade windows in workspace.
F6: Activate next Money Smith window in workspace.
F10: Moves cursor to the menu.
F12: Save file as another name.
Shift+F1: Activate Money Smith point and press help.
Alt+F4: Exit Money Smith prompting user to save files.
Ctrl+F12: Open an existing Money Smith file.
Ctrl+Shift+F12: Print the active Money Smith file, graph, or report.



About Money Smith command
This command displays the title, copyright statement, author, version, registration number 
and licensed user name.

Money Smith Version 1.2
Money Smith V1.2 was developed in the Spring of 1991 from scratch by Bradley J. Smith 
using Borland C++ for Windows.    An extensive three month beta test period followed 
including at least four beta test versions and two test releases.    The version you hold 
includes nearly 10,000 lines of documented C code with another few thousand lines of on-
line help.    It represents the very best in shareware and many hundreds of hours of my 
sweat.    Believe it or not, I have a full time job as well.

Dedication:
Many thanks to my wife and daughter for putting up with my long hours.    This program is 
dedicated to them and my love for them.

Borland C++ is a trademark of Borland International.



Account File
A Money Smith file containing a complete set of accounts and transactions.    You have one 
account file for each separate budget. (Home, Business, etc...)    All account files end with 
the ".ACT" file extension.



Account
An account represents either a tangible asset or liability or else it represents a flow of money
like an income or expense.    Examples include checking, savings, credit cards, paychecks, 
food, rent, etc...



Asset
An asset account represents a real account or hard asset.    Examples include: checking, 
savings, mutual funds, stocks, bonds, accounts receivable, house, furniture, boat, car, 
computer, whole life insurance value, etc...



Liability
A liability account represents a lien or contract to pay someone.    Examples include: credit 
cards, loans, car loans, mortgages, lines of credit, promissory notes, accounts payable, 
etc....



Income
An income account represents a flow of money in or earning of income.    Examples include: 
your paycheck, interest income, dividend income, business revenues, gifts from others, etc...



Equity
An equity account represents your net worth (Assets minus Liabilities).    You don't normally 
need to create any equity accounts because Money Smith will calculate your starting and 
retained equity for you.    Examples include: common stock or starting capital for a small 
business, etc...



Expense
An expense account represents the expenditure of money.    Examples include: rent, utilities, 
food, purchases, car repair, gas, cable, most bills, etc...



Transaction
A transaction represents a flow of money from one account to another on a particular date.    
The amount is transferred from the 'From' account to the 'To' account on the given date by 
Money Smith.    Examples: checks, withdrawals, purchases, etc...



Graph
A    graph window is used to graphically represent account balances and investment 
information.    Graph windows are automatically updated as accounts change and can be 
manipulated using window controls and the graph menu bar.    



Report
A    report window is used to display summaries of account and investment information.    
Report windows are automatically updated as accounts change and can be manipulated 
using window controls and the report menu bar.



View
A view defines what will be displayed in the main account window.    There are three views: 
Account view displays a list of accounts.    Transaction view displays all current transactions.   
Register view displays all transactions for the current account.



Account Category
A label used to group accounts of a similar type.    For example you might establish an 
entertainment    category and assign your 'going out' expense accounts to it to better track 
entertainment expenses.    Examples include: IRA's, investment portfolios, groups of 
expenses, receivables, etc.... 



Investment Account
A special account usually used to represent a stock, bond, mutual fund, or some other 
security.    An investment account has a separate database of prices and investments to help
you track the performance of the underlying security. 



Automatic Investment
An automatic investment reminds Money Smith users to enter investment amounts and 
prices on a recurring basis.    This is usually done in conjunction with some kind of recurring 
investment or desire to update the price.    The feature can also be used to record real 
transactions related to these investment accounts.



Recurring Transaction
Any transaction that occurs on a regular recurring basis.    Examples: rent, paychecks, 
monthly bills, etc...      Money Smith allows you to enter these transactions once and then 
either automatically reminds you or adds the transaction for you as dates occur.



Password
A password protects your Money Smith files from unauthorized access.    No one can open 
the file without typing in the correct password.    Don't forget your password, since even you 
cannot open the file if you don't know it.



Licensing Terms
Money Smith Copyright (c) 1991 by Bradley J. Smith

All Rights Reserved.
GENERAL LICENSE TERMS:

Use of this program for any period of time equates to agreement to all terms of this 
license.

Money Smith is only one possible tool for financial management.    You should make NO 
FINANCIAL DECISIONS WHATSOEVER based on the feedback Money Smith provides.    IN NO 
CASE WILL MONEY SMITH SYSTEMS OR BRADLEY J. SMITH BE HELD LIABLE FOR ANY 
DAMAGES RESULTING FROM THE USE OF THIS PROGRAM. 

Money Smith is not and has never been public domain software, nor is it free software.

 Unregistered users are granted a limited single user license to use the 
shareware version of Money Smith on a 30-day trial basis for the purpose of 
determining whether Money Smith is suitable for their needs.    Use of Money 
Smith, beyond the initial 30-day trial requires registration.    The use of unlicensed
copies of Money Smith outside of the initial 30-day trial, by any person, business, 
corporation,    government agency or any other entity is strictly prohibited.

        A single user license permits users to use Money Smith only on a single computer.    
Licensed users may use the program on different computers as long as the program is not 
used on more than one computer at a time.

SOFTWARE LICENSE:

Shareware and Beta versions:
The shareware (unregistered) and all beta test versions of Money Smith are provided "AS

IS" with no warranty at all either express or implied.    MONEY SMITH SYSTEMS AND BRADLEY
J. SMITH HEREBY DISCLAIM ALL WARRANTIES WITH REGARD TO THE USE OF THE 
UNREGISTERED (SHAREWARE) VERSION OF THIS PRODUCT INCLUDING BUT NOT LIMITED TO 
ALL IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.    
THE USER OF THIS SOFTWARE ASSUMES ALL RISKS FOR ANY DAMAGES WHATSOEVER 
RESULTING FROM THE USE OF THIS SOFTWARE 

Limited Distribution Rights
A limited license is granted to copy and distribute the unregistered shareware version of 

Money Smith subject to the conditions above and the following:

1) No fee, charge or compensation may be accepted for distribution of Money Smith 
except:

A)      Time related usage fees for electronic bulletin boards not directly related to the 
downloading of this program.

B) Association of Shareware Professionals (ASP) member distributors may charge a 
nominal fee of no more than $5 to distribute this shareware version.

C)    Others wishing to charge a fee not provided for above can do so only with the 
express written consent of Money Smith Systems or Bradley J. Smith.



2) No one may modify Money Smith files, documentation, or executables in any way, 
including reverse engineering the program.

3) The full machine readable documentation, help files, executable, and examples must 
be included with each copy.

4) Association of Shareware Professionals (ASP) member distributors may charge a 
nominal fee of no more than $5 to distribute the shareware version.

Registered licensed versions

You can obtain a registered licensed version of Money Smith from Money Smith Systems 
by remitting payment to the address described in attached documentation file register.txt.    
You can look at and print this file using the windows notepad application.    Site licenses are 
available - write for details.

No one may not copy or distribute any portion of the registered documentation,    files, or
executables except for registered users with the express purpose of backing up these files    
for personal use on their own system as described in the single user license terms above.    
Copying or distributing the registered files to any other person, corporation, or other entity is
strictly prohibited.

LIMITED WARRANTY FOR REGISTERED USERS ONLY

Money Smith Systems warrants that the disks provided with the registered licensed 
version of Money Smith are free from defects for a period of 90 days from the purchase date.
You may return defective disks to the purchase place for replacement or a full refund.    For 
refunds the complete package including documentation must be returned in a sealed state.   
Money Smith systems also agrees to provide mail software support for a period of 90 days 
from the original purchase date.    Just mail a description of your question or problem to 
Money Smith Systems, P. O. Box 333, Converse, TX 78109.

GENERAL TERMS:

EXCEPT AS PROVIDED ABOVE MONEY SMITH SYSTEMS AND BRADLEY J. SMITH DISCLAIM ALL 
WARRANTIES WITH RESPECT TO THIS PRODUCT, EITHER EXPRESS OR IMPLIED, INCLUDING, 
BUT NOT LIMITED TO IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE.    SHOULD THE PRODUCT PROVE DEFECTIVE IN ANY WAY THE 
PURCHASER ASSUMES THE RISK OF SERVICING, REPAIR, CORRECTION, INCIDENTAL, OR 
CONSEQUENTIAL DAMAGES. (INCLUDING BUT NOT LIMITED TO DAMAGES RESULTING FROM 
INVESTMENT DECISIONS MADE, BUSINESS PROFITS LOST, INTERRUPTION OF BUSINESS,    
LOSS OF INFORMATION AND THE LIKE) USING THIS SOFTWARE.

LIMITATION OF LIABILITY:

IN ANY CITY, STATE, COUNTY, CASE, OR SITUATION WHERE WARRANTIES OR LIABILITY FOR 
DAMAGES CANNOT BE WAIVED MONEY SMITH SYSTEMS AND BRADLEY J. SMITH HEREBY 
LIMIT THEIR LIABILITY TO THE ORIGINAL PURCHASE PRICE OF THE SOFTWARE.    PURCHASER 
OF SOFTWARE AGREES NOT TO HOLD MONEY SMITH SYSTEMS OR BRADLEY J SMITH LIABLE 
FOR ANY DAMAGES WHATSOEVER BEYOND REFUND OF THE ORIGINAL PURCHASE PRICE OF 
THE SOFTWARE IN CASES WHERE WARRANTIES OR LIABILITY CANNOT BE WAIVED.

Association of Shareware Professionals (ASP) Ombudsman Statement
"Bradley J. Smith is a member of the Association of Shareware Professionals (ASP).    ASP 
wants to make sure that the shareware principle works for you. If you are    unable to resolve 
a shareware-related problem with an ASP member by contacting the member directly, ASP 



may be able    to help. The ASP Ombudsman can help you resolve a dispute or problem with 
an ASP member, but does not provide    technical support for members' products. Please 
write to the ASP Ombudsman at 545 Grover Road, Muskegon, MI 49442 or send a 
CompuServe message via CompuServe Mail to ASP Ombudsman 70007,3536."

Acknowledgements
Money Smith is a trademark of Bradley J. Smith.
Microsoft, Windows, Paintbrush, Notepad, DOS, Word, Excel are all trademarks of Microsoft.
Borland C++ is a trademark of Borland International.
The Association of Shareware Professionals (ASP) is a non-profit group dedicated to the 
shareware profession.



System Commands
System commands are activated from the System menu box in the top left corner of the 
window or by clicking the icon if the window is minimized.

Commands under the System menu box:
System Restore command Restore window to previous size.
System Move command Move window.
System Size command Change the size of a window.
System Minimize command Shrink window to an icon.
System Maximize command Size window to full screen.
System Close command Close window.
System Switch To command Switch to another task.
System Next command Switch to next document.
System Scrollbar Scroll the window vertically or horizontally.

Other menu Commands:
Command Index Index of other menu commands.



System Restore command
The System Restore command restores a window to its previous size on the screen after 
either a System Minimize or System Maximize command.    Double clicking the title bar at 
the top of the window or icon for the window also performs this function.

Procedure:

1. Choose the Restore command from the System box menu in the upper left corner of 
the window, or double click the icon or title bar of the window you want to restore.

Related Topics:
System Commands Other System Commands.
System Minimize command Shrink window to an icon.
System Maximize command Size window to full screen.



System Move command
The System Move command and title bar on a window let you move that window to another 
location in the desktop.    

Procedure:

1. Choose the System Move command from the System box menu in the upper left 
corner of the window,    or press and drag the title bar of the window with your mouse 
to move the window.

Related Topics:
System Commands Other System Commands.
System Size command Change the size of a window.



System Size command
The System Size command and sizing frames on a window let you resize a window on the 
desktop. 

Procedure:

1. Choose the System Size command from the System box menu in the upper left corner 
of the window,    or press and drag the sizeing frame on the window to resize the 
window.

Related Topics:
System Commands Other System Commands.
System Move command Move window.



System Minimize command
The System Minimize command and minimize (down arrow) box on a window let you shrink a
window on the desktop to icon size. 

Procedure:

1. Choose the System Minimize command from the System box menu in the upper left 
corner of the window,    or press the minimize (down arrow) button on the top right of 
the window to minimize the window.

Related Topics:
System Commands Other System Commands.
System Maximize command Size window to full screen.
System Restore command Restore window to previous size.



System Maximize command
The System Maximize command and maximize (up arrow) box on a window let you expand a
window to full screen or restore it to its previous size if already maximized. 

Procedure:

1. Choose the System Maximize command from the System box menu in the upper left 
corner of the window,    or press the maximize (up arrow) button on the top right corner 
of the window to maximize the window.

Related Topics:
System Commands Other System Commands.
System Minimize command Shrink window to an icon.
System Restore command Restore window to previous size.



System Switch To command
The System Switch To command displays a task list of current windows applications and lets 
you chose another application to run. 

Procedure:

1. Choose the System Switch To command from the System box menu in the upper left 
corner of the window,    or double click the display desktop to bring up the task list.

2. Choose the task you want to switch to and press the switch to button or press the 
cancel button to return to your original application.

Related Topics:
System Commands Other System Commands.
System Next command Switch to next document.



System Next command
The System Next command activates the next window in the multi-document Money Smith 
workspace.

Procedure:

1. Choose the System Next command from the System box menu in the upper left corner
of the Money Smith account, graph, or report window.

Related Topics:
System Commands Other System Commands.
Window Commands Window Commands.
System Switch To command Switch to next document.



System Scrollbar
The System Scrollbar lets you scroll the window vertically.

Procedure:

1. Press the scrollbar with the mouse.    Dragging the square thumb scrolls the window 
that amount.    Pressing the up and down arrows of the scrollbar scrolls up or down one 
line.    Pressing the area between the arrows and scroll thumb pages up and down.

Related Topics:
System Commands Other System Commands.





File Commands
Commands under the File menu:

File New command Create a new file.
File Open command Open and existing file.
File Close commandClose an open window or file.
File Save command Save current file.
File Save As command Save active window to a new file name
File Delete command Delete a file.
File Print command Set up printer.
File Printer Setup command Set up printer.
File Exit command Exit Money Smith.
File 1, 2, 3 command Directly open a previously used file.

Other menu Commands:
Command Index Index of other menu commands.



File New command
The File New command creates a new Money Smith account file and opens it for editing.    
Account files are created with no accounts or transactions defined.

Procedure:

1.    Choose the File New command from the menu.
2.    Add new accounts and transactions as you please.

Related Topics:
File Commands Index of file commands.
File Open command Open and existing file.
File Close commandClose an open file.



File Open command
The File Open command opens an existing Money Smith account file and displays it using 
the saved view of the account.    The account is open for editing.

Procedure:

1.    Choose the File Open command from the menu or hold down the Ctrl key and press 
the F12 key.

2.    Type or select the name of the file you want to open.
3.    If the file you want is not in the current directory, type the name of the directory or 

drive you want in front of the named file or select it from the directory list and press 
OK.

4.    Press OK or double click the selection with the mouse to open it.
5.    If the file has a password, automatic investment, or any recurring transactions 

defined these may run at this time.

Related Topics:
File Commands Index of file commands.
File 1, 2, 3 command Directly open a previously used file.
Investments Editing Investments.
Recurring Transactions Recurring transactions.
Set Password Setting a password for an account.



File Close command
The File Close command closes the existing window after asking the user to save the file if 
the current window is an account file and changes have been made to the file.    Current 
graphs and reports are closed automatically by this command.

Procedure:

1.    Select the account, report, or graph window you want to close.
2.    Choose the File Close command from the menu.
3.    If you have made changes and want to save them, answer Yes to the save dialog.
4.    If you have not assigned a name to your account you will be prompted to enter one 

now.

Related Topics:
File Commands Index of file commands.
File Exit command Exit Money Smith.
Window Close All command Close all open windows.
File Save command Save current file.



File Save command
The File Save command saves the active account file using the existing file name.    If no 
name has been attached to this account, then the user is prompted for a name.    All account
files are saved with ".ACT" extensions.

Procedure:

1.    Select the account window you want to save to make it active.
2.    Choose the File Save command from the menu or press the F3 function key.
3.    If this is a new file, you will be prompted for a name to save the file as.

Related Topics:
File Commands Index of file commands.
File Save As command Save active window as another name.
File Close command Close active window.



File Save As command
The File Save As command saves the active account file or report    allowing you to type in a 
new file name.    You are prompted for a name in the file save as dialog box.    All account 
files are saved with ".ACT" extensions.    All reports are saved as "*.TXT" files.

Procedure:

1.    Select the account or report window you want to save to make it active.
2.    Choose the File Save As command from the menu or press the F12 function key.
3.    You will be prompted for a name to save the file as.    You can either choose an 

existing file (which will be overwritten by this one) or directory or type in the name of 
the file you want this one saved as.

4.    After running the File Save As command the active window will take the new file 
name you typed and any subsequent saves will be to this new file name.

Related Topics:
File Commands Index of file commands.
File Save command Save the active window.
File Close command Close active window.



File Delete command
The File Delete command can be used to delete account files from your disk.    Once deleted 
a file cannot be recovered.

Procedure:

1.    Choose the File Delete command from the menu.
2.    Type or select the name of the file you want to delete.
3.    If the file you want is not in the current directory, type the name of the directory or 

drive you want in front of the named file or select it from the directory list and press 
OK.

4.    Press OK or double click the selection with the mouse to delete it.
5.    Answer Yes to the 'Are you sure?' message to delete the file.

Related Topics:
File Commands Index of file commands.



File Print command
The File Print command prints the active view , graph or report on your currently active 
printer.    Colors are automatically converted to patterns for monochrome printers.    You can 
use the File Printer Setup command to change the printer settings.

Procedure:

1.    Select the account, graph, or report window you want to print to make it active.
2.    Choose the File Print command from the menu or press the Ctrl-Shift-F12 key 

combination.
3.    Press the Cancel button if you want to stop the print job, or halt it using the print 

manager.

Related Topics:
File Commands Index of file commands.
File Printer Setup command Set up printer.
File Save As command Save active window to a file.



File Printer Setup command
The File Printer Setup command lets you set the current printer and access your printer 
setup dialog.    You can use the File Print command to print Money Smith windows and 
reports.

Procedure:

1.    Select the File Printer Setup command from the menu.
2.    Select the printer you want to make active.
3.    Press OK to make this the current printer.
4.    Press the Setup button if you want to change any printer settings.

Related Topics:
File Commands Index of file commands.
File Print command Set up printer.



File Exit command
The File Exit command closes all existing windows and exits the Money Smith program.    
Before exiting each the user is asked to save each account file if changes have been made.   
Current graphs and reports are closed automatically by this command.

Procedure:

1.    Choose the File Exit command from the menu.
2.    If you have made changes and want to save them, answer Yes to the save dialog.
3.    If you have not assigned a name to an account file you will be prompted to enter one

now.

Related Topics:
File Commands Index of file commands.
File Close command Close current window.
Window Close All command Close all open windows.



File 1,2,3... command
The File 1,2,3... command opens an recently used Money Smith account file and displays it 
using the saved view of the account.    The account is open for editing.

Procedure:

1.    Choose the numbered file you want to open from the File menu.
2.    If the file has a password, automatic investment, or any recurring transactions 

defined these may run at this time.

Related Topics:
File Commands Index of file commands.
File Open command Open an existing file.
File New command Create a new file.
File Close command Close an open file.



Edit Commands
Commands under the Edit menu:

Edit Cut command Cut an account or transaction to clipboard.
Edit Copy command Copy an account or transaction to clipboard.
Edit Paste command Paste an account or transaction from clipboard.
Edit Add command Add a new account or transaction.
Edit Edit command Edit the current account or transaction.
Edit Delete command Delete the current account or transaction.

Other menu Commands:
Command Index Index of other menu commands.



Edit Cut command
The Edit Cut command cuts the currently selected account or transaction to the clipboard.    
The current account or transaction is deleted from the active window.    Cut items may be 
pasted to this or another account window.

Procedure:

1. Select the account or transaction you want to cut.
2. Choose the Edit Cut command from the menu.
3. Answer Yes if you are sure you want it cut.

Warnings:
You must be in an account view to cut an account.
You must be in a transaction view to cut a transaction.
You cannot delete an account that still has transactions defined against it.

Related Topics:
Edit Commands Other edit menu commands.
Edit Copy command Copy an account or transaction to clipboard.
Edit Delete command Delete the current account or transaction.
Edit Paste command Paste an account or transaction from clipboard.



Edit Copy command
The Edit Copy command copies the currently selected graph, report, account or transaction 
to the clipboard.    Copied accounts and transactions may be pasted to this or another 
account window.    You can paste graphs into any graphics tool like paint.    You can paste 
reports into any text editor or word processor like notepad or write.

Procedure:

1. Select the graph, report, or account or transaction you want to copy.
2. Choose the Edit Copy command from the menu.

Warnings:
You must be in an account view to copy an account.
You must be in a transaction view to copy a transaction.

Related Topics:
Edit Commands Other edit menu commands.
Edit Cut command Cut an account or transaction to clipboard.
Edit Paste command Paste an account or transaction from clipboard.



Edit Paste command
The Edit Paste command copies an account or transaction from the clipboard to the currently
active account. 

Procedure:

1. Select the account or transaction view you want to paste this item into.
2. Choose the Edit Paste command from the menu.

Warnings:
You must be in an account    view to paste an account.    Account names must be unique.
You must be in a transaction view to paste a transaction.

Related Topics:
Edit Commands Other edit menu commands.
Edit Cut command Cut an account or transaction to clipboard.
Edit Copy command Copy an account or transaction to the clipboard.



Edit Add command
The Edit Add command adds a new account or transaction to the currently active account 
window.

Procedure:

1. Select the account or transaction view you desire.
2. Choose the Edit Add command from the menu or select the '+' Toolbar icon next to the

current view.
3. Edit the Account Dialog or Transaction Dialog.
4. Press the Save button to save the account or the Another button to save the account 

and create another.

Related Topics:
Edit Commands Other edit menu commands.
Account Dialog Description of the account editing dialog.
Toolbar The Money Smith toolbar.
Edit Edit command Edit the current account or transaction.
Edit Delete command Delete the current account or transaction.



Edit Edit command
The Edit Edit command edits the current    account or transaction.

Procedure:

1. Select the account or transaction using arrow keys or the mouse.
2. Choose the Edit Edit command from the menu.

OR select the ' * ' Toolbar icon next to the current view
OR double click the current account or transaction
OR press the enter key.

3. Edit the Account Dialog or Transaction Dialog.
4. Press the Save button to save the account.    Press the Cancel button to throw changes

away.

Related Topics:
Edit Commands Other edit menu commands.
Account Dialog Description of the account editing dialog.
Toolbar The Money Smith toolbar.
Edit Add command Add a new account or transaction.
Edit Delete command Delete the current account or transaction.



Edit Delete command
The Edit Delete command deleted the current    account or transaction.

Procedure:

1. Select the account or transaction you want to delete using arrow keys or the mouse.
2. Choose the Edit Delete command from the menu.

OR select the ' - ' Toolbar icon next to the current view.
3. Press the Yes button to delete the account if you are sure. .

Warnings:
You cannot delete an account that still has transactions defined against it.

Related Topics:
Edit Commands Other edit menu commands.
Toolbar The Money Smith toolbar.
Edit Add command Add a new account or transaction.
Edit Edit command Edit the current account or transaction.





View Commands
Commands under the View menu:

View Account command View account list.
View Transaction command View current transactions.
View Register command View current account's transactions.
View Toolbar command Toggle Toolbar on and off.
View Statusbar command Toggle Statusbar on and off.
View Grid command Toggle grid lines on and off.
View Date command Change the currently viewable date.

Other menu Commands:
Command Index Index of other menu commands.



View Account command
The View Transaction command displays a list of all current transactions in the account 
window.

Description:

Name:    Name of the account.
Type:    Either Asset, Liability, Income, Equity, or Expense
Dates:    Balance of accounts as of these starting and ending dates.

Procedure:

1. Choose the View Account command from the menu or choose the 'Acct:' button on the
Toolbar .

Related Topics:
View Commands Other View Commands.
View Transaction command View current transactions.
View Register command View current account's transactions.
View Grid command Toggle grid lines on and off.
View Date command Change the currently viewable date.



View Transaction command
The View Transaction command displays a list of current transactions in the current account 
window.    Only transactions that fall within the current accounting dates are displayed.

Description:

Date:  Date of the transaction.
# : Check number of the transaction.
Transaction: Description of the transaction.
To: Account transaction moves money to.
From: Account transaction moves money from.
Amount: Dollar amount of the transaction.

Procedure:

1. Choose the View Transactions command from the menu or choose the 'Txacts' button 
on the Toolbar .

Related Topics:
View Commands Other View Commands.
View Account command View account balances.
View Register command View current account's transactions.
View Grid command Toggle grid lines on and off.
View Date command Change the currently viewable dates.



View Register command
The View Register command displays a list of transactions that involve the current 
account.Only transactions that fall within the current accounting dates and affect the current
account are displayed.

Description:

Date:    Date of the transaction.
# : Check number of the transaction.
Transaction: Description of the transaction.
To/From: Account this transaction is moving money to or from.
Amount: Dollar amount of the transaction.
Balance:    Balance of the current account after this transaction.

Procedure:

1. Choose the View Register command from the menu or choose the 'Register' button on 
the Toolbar .

Related Topics:
View Commands Other View Commands.
View Account command View account balances.
View Transactions command View all current transactions.
View Grid command Toggle grid lines on and off.
View Date command Change the currently viewable dates.



View Toolbar command
The View Toolbar command toggles the display of the Money Smith toolbar.    The toolbar 
places frequently used menu commands on individual pushbuttons for easier use.

Description: Press the corresponding toolbar button with the mouse to perform these 
functions.

Current account:    The current account name is in a white box on the toolbar.
?: Money Smith interactive help - just press this button and press the item you want help

on.
Acct: Switches to the Account View displaying the list of accounts.
Acct +: Adds a new account.
Acct *:    Edits the current account.
Acct -:    Deletes the current account.
Txact: Switches to the Transaction View displaying the list of current transactions.
Txact +: Adds a new transaction.
Txact *:    Edits the current transaction.
Txact -:    Deletes the current transaction.
Date: Sets the currently    viewable dates.
Invest: Edits previously defined investment accounts.
Recur: Edits    recurring transactions.

Procedure:

1. Choose the View Toolbar command to toggle the toolbar on and off.

Related Topics:
View Commands Other View Commands.



View Statusbar command
The View Statusbar command toggles the display of the Money Smith status bar.    The status
bar displays expanded menu commands and other pertinent information at the bottom of 
the Money Smith window.

Procedure:

1. Choose the View Statusbar command to toggle the status bar on and off.

Related Topics:
View Commands Other View Commands.



View Grid command
The View Grid command toggles the display of Grid lines in various account views.    Grid 
lines make accounts more viewable, but slow printing.

Procedure:

1. Choose the View Grid command to toggle the grid on and off.

Related Topics:
View Commands Other View Commands.



View Date command
The View Date command lets you change the start and end dates used to calculate and 
display all balances, accounts,    transactions,    reports,    and graphs.    Only transactions 
between the starting and ending dates are displayed in transaction or register views.    You 
can change the current date which helps in adding old transactions.

Procedure:

1. Choose the View Date command.
2. Fill out the starting date, end date, and current date.
3. All account balances, transactions, graphs, and reports will automatically reflect the 
new dates.

Related Topics:
View Commands Other View Commands.





Options Commands
Commands under the Options menu:

Options Recurring Transactions command Edit recurring transactions.
Options Category command Edit category list.
Options Investments command Edit invesment accounts.
Options End of Year command Perform end of year processing.
Options Password command Set or reset password for account.
Options Report Title command Set the title for graphs and reports.

Other menu Commands:
Command Index Index of other menu commands.



Options Recurring Transaction command
The Options Recurring Transaction command displays a list of current recurring transactions 
and lets you edit the list.

Procedure:

1. Choose the Options Recurring Transactions command from the menu or choose the 
'Recur' button on the Toolbar .

To Add: Press the 'Add' button and fill out the Transaction dialog.
To Edit: Select the transaction, press the 'Edit' button and fill out the Transaction dialog.
To Run: Select the transaction, press the 'Run' button and edit the date on the 

Transaction dialog.    This records a single transaction in the transaction list.
To Delete: Select the transaction, press the 'Delete' button.
To Quit: Select the 'Quit' button to get out of the recurring transaction editor.

Related Topics:
Options Commands Other Options Commands.
Transaction dialog. The transaction editing dialog.



Options Category command
The Options categories command displays a list of current account categories and lets you 
edit the list.

Procedure:

1. Choose the Options Category command from the menu.

To Add: Press the 'Add' button and fill out the category name.
To Edit: Select the category from the list, press the 'Edit' pushbutton and fill out 

category name.
To Delete: Select the category to delete, and press the 'Delete' pushbutton.
To Quit: Select the 'Quit' pushbutton to get out of the category editor.

Related Topics:
Options Commands Other Options Commands.



Options Investment command
The Options Investment command displays a list of accounts with investments and lets you 
edit the list.

Procedure:

1. Choose the Options Investment command from the menu or choose the 'Invest' button
on the Toolbar ..

To Edit: Select the investment from the list, press the 'Edit' pushbutton and fill out the 
investment dialog.

To Quit: Select the 'Quit' pushbutton to get out of the investment editor.
To Add or Delete: You must add and delete investments using the account dialog. 

Select the Edit Edit command to edit the current account.

Related Topics:
Options Commands Other Options Commands.
Account Dialog Account editing dialog.
Edit Edit command Edit the current account.



Options End of Year command
The Options End of Year command rolls your transactions out to let you start a new 
accounting period.    It can be run quarterly, semianually, or even monthly if you have a lot of
transactions.    The process saves the old file under a new name if desired, and then rolls out 
all transactions and investment records that have a date before the current end date.    
Account starting balances are adjusted to reflect the transactions rolled out.

Procedure:

1. Choose the Options End of Year command from the menu and answer the questions 
that follow.

Related Topics:
Options Commands Other Options Commands.
View Date Change the current accounting start and closeout dates.



Options Password command
The Options Password command sets or changes your password.    Please don't forget your 
password since you cannot open an acount file that has a password without it.

Procedure:

1. Choose the Options Password command from the menu.
2. To change: enter your old and new passwords.
3. To Set: enter your new password.
4. To Unset: enter your old password, leave the new password fields blank.

Related Topics:
Options Commands Other Options Commands.



Options Report Title command
The Options Report Title command sets or changes the title that appears at the top of all of 
the reports and graphs for this account file.    The title is saved with the account file. 

Procedure:

1. Choose the Options Report Title command from the menu.
2. Enter the new report title string.
3. Press OK to save the change, or Cancel to forget it.

Related Topics:
Options Commands Other Options Commands.
Report Commands Report Commands.



Report Commands
Commands under the Report menu:

Report Balance Statement command Create a balance report window.
Report Income Statement command Create an income report window.
Report Budget Report command Create a budget report window.
Report Tax Summary command Create a tax summary report window.
Report Reconcile Current Account command Create a reconciliation report.
Report Category command Create a balance report window.
Report Investment Summary command Create an investment summary window.

Other menu Commands:
Command Index Index of other menu commands.



Report Balance Statement command
The Report Balance Statement command creates a new Money Smith report window and 
opens it for viewing.      The balance statement totals your current assets, liabilities, and 
equity, to compute you net equity which is the same as your net worth.    All balances are 
computed as of    the end of the current accounting dates.

Description:

Name: Shows the name of each account.
Balance: Shows the current account balance in dollars.
Percent: Shows the percentage this account is relative to total assets, liabilities, or 

equity.

Procedure:

1.    Choose the Report Balance Statement command from the menu.

Related Topics:
Report Commands Other Reports.
Report Income Statement command Create an income report window.



Report Income Statement command
The Report Income Statement command creates a new Money Smith report window and 
opens it for viewing.      The income statement totals your income and expenses for the 
current accounting dates and displays your net income (income minus expenses).

Description:

Name: Shows the name of each account.
Balance: Shows the total income or expense in dollars.
Percent: Shows the percentage this account is relative to total income or expenses.

Procedure:

1.    Choose the Report Income Statement command from the menu.

Related Topics:
Report Commands Other Reports.
Report Balance Statement command Create a balance report window.



Report Budget Report command
The Report Budget Report command creates a new Money Smith report window and opens it
for viewing.      The budget report compares actual to budgeted income and expenses for the 
current accounting period and shows the percent difference between them.    Budgets can be
set for each income and expense account using the Edit Add command from account view 
ort pressing the '+' button on the toolbar.    Totals are displayed below income and expense 
accounts.

Description:

Name: Shows the name of each account.
Budget: Shows the budget set for the account in dollars.
Actual: Shows the actual income or expenses for the account in dollars.
Difference: Shows the difference between budgeted and actual income and expense.
Percent: Shows the percentage difference between actual and budgeted values.

Procedure:

1.    Choose the Report Budget Report command from the menu.

Related Topics:
Report Commands Other Reports.



Report Tax Summary command
The Report Tax Summary command creates a new Money Smith report window and opens it 
for viewing.      The report shows taxable and non-taxable    income and expenses for the 
current accounting period and shows the percentage of totals.    Totals for both taxable and 
non-taxable income and expenses are shown below the accounts in each category.

Description:

Name: Shows the name of each account.
Balance: Shows the actual income or expenses for the account in dollars.
Percent: Shows the percentage of taxable or non-taxable income or expense.

Procedure:

1.    Choose the Report Tax Summary command from the menu.

Related Topics:
Report Commands Other Reports.



Report Reconcile Account command
The Report Reconcile Account command creates a new Money Smith report window and 
opens it for viewing.      The report shows a list of all transactions for the current account 
within the accounting period and prints running balances of cleared transactions (marked 
with an X) and total transactions.    By correcting cleared flags and comparing with your bank
statement for the account you should be able to balance your account fairly easily.

Description:

Date: Shows the date of each transaction.
Description: Shows the description of each transaction.
Amount: Shows the amount of the transaction in dollars.
C: Marked with an X if this transaction is cleared.
Balance: Running balance including all transactions.
Cleared: Running balance including only transactions that have cleared.

Procedure:

1.    Choose the Report Reconcile Account command from the menu.

Related Topics:
Report Commands Other Reports.



Report Category Report command
The Report Category Report command creates a new Money Smith report window and opens
it for viewing.      The report shows a list of all accounts    assigned to categories with balance 
totals and percentages for each category.

Description:

Name: Shows the name of each account.
Balance: Shows the current account balance in dollars.
Percent: Shows the percentage this account is relative to the total for the category.

Procedure:

1.    Choose the Report Category Report command from the menu.

Related Topics:
Report Commands Other Reports.
Graph Category Command Graph a category.



Report Investment Summary command
The Report Investment Summary command creates a new Money Smith report window and 
opens it for viewing.      The report shows a list of all investments    defined and displays the 
investment history for each.    These histories should closely match mutual fund or stock 
statements for easy record keeping.    All investment transactions are displayed regardless of
the current dates.    Most recent value and performance information is placed at the bottom.

Description:

Date: Shows the date of each investment transaction.
Description: Shows the description of each investment transaction.
Amount: Shows the amount of the transaction in dollars.
Price: Displays the share price at the time of the investment transaction
Tx Shares: Shows the number of shares purchased with this investment transaction.
Tot Shares: Shows the total number of shares purchased as of transaction date.

Procedure:

1.    Choose the Report Investment Summary command from the menu.

Related Topics:
Report Commands Other Reports.
Graph Investment command Graph an investment.





Graph Commands
Commands under the Graph menu:

Graph Assets command Graph current assets.
Graph Liabilities command Graph current liabilities.
Graph Equity command Graph current equity.
Graph Income command Graph current income.
Graph Expense command Graph current expenses.
Graph Category command Graph a single category.
Graph Current Investment command Graph the current account's investment info.

Other menu Commands:
Command Index Index of other menu commands.



Graph Assets command
The Report Balance Statement command creates a new Money Smith graph window and 
opens it for viewing.      The pie graph shows    the current assets    balances in all asset 
accounts, with positive balances.    All balances are computed as of    the end of the current 
accounting dates and the percentages shown are percent of total positive balance asset 
accounts.

Procedure:

1.    Choose the Graph Assets command from the menu.

Related Topics:
Graph Commands Other Graphs.
Report Balance Statement command Create a balance report window.



Graph Liabilities command
The Graph Liabilities command creates a new Money Smith graph window and opens it for 
viewing.      The pie graph shows    the current liabilities    balances in all liability accounts, 
with positive balances.    All balances are computed as of    the end of the current accounting 
dates and the percentages shown are percent of total positive balance liability accounts.

Procedure:

1.    Choose the Graph Liabilities command from the menu.

Related Topics:
Graph Commands Other Graphs.
Report Balance Statement command Create a balance report window.



Graph Equity command
The Graph Equity command creates a new Money Smith graph window and opens it for 
viewing.      The pie graph shows    the current equity (net worth)    balances in all equity 
accounts, with positive balances.    All balances are computed as of    the end of the current 
accounting dates and the percentages shown are percent of total positive balance equity 
accounts.

Procedure:

1.    Choose the Graph Equity command from the menu.

Related Topics:
Graph Commands Other Graphs.
Report Balance Statement command Create a balance report window.



Graph Income command
The Graph Income command creates a new Money Smith graph window and opens it for 
viewing.      The pie graph shows    the current income    balances in all income accounts, with 
positive balances.    Income is    computed for the current accounting dates and the 
percentages shown are percent of total positive balance income accounts.

Procedure:

1.    Choose the Graph Income command from the menu.

Related Topics:
Graph Commands Other Graphs.
Report Income Statement command Create an income report window.



Graph Expense command
The Graph Expense command creates a new Money Smith graph window and opens it for 
viewing.      The pie graph shows    the current expense    balances in all expense accounts, 
with positive balances.    Expenses are    computed for the current accounting dates and the 
percentages shown are percent of total positive balance expense accounts.

Procedure:

1.    Choose the Graph Expense command from the menu.

Related Topics:
Graph Commands Other Graphs.
Report Income Statement command Create an income report window.



Graph Category command
The Graph Category command lets you choose a category and account type to graph, and 
then creates a new Money Smith graph window and opens it for viewing.      The pie graph 
shows    the current    accounts with positive balances in the chosen category.    Percentages 
displayed are a percent of the total for the category.

Procedure:

1.    Choose the Graph Category command from the menu.
2.    Choose the category and account type you wish to graph from the lists displayed.

Related Topics:
Graph Commands Other Graphs.
Report Category Report command Create a category report window.



Graph Current Investment command
The Graph Current Investment command uses the current    investment account to create a 
new Money Smith graph window.      Three different graphs can be created from the sub-
menu.    Each is a bar graph of the investment history over time.

Procedure:

1.    Select the Investment account you want to graph to make it the current account.
2.    Choose the Graph Current Investment command from the menu.
3.    Choose one of the following command from the investment sub-menu:

Price will display the price history of the investment.
Value will display the valuation history of the investment.
Return will show the percent return history of the investment.

Related Topics:
Graph Commands Other Graphs.
Report Investment Summary command Create an investment summary report window.





Window Commands
Commands under the Window menu:

Window Tile command Tile windows in workspace.
Window Cascade command Cascade windows in workspace.
Window Arrange Icons command Arrange Icons in workspace.
Window Close All command Close all windows in workspace.
Window 1,2,3... command Activate a window.

Other menu Commands:
Command Index Index of other menu commands.



Window Tile command
The Window Tile command tiles all active windows across the workspace, evenly dividing the
workspace across the number of active windows.

Procedure:

1. Choose the Window Tile command or press the F4 key to tile windows.

Related Topics:
Window Commands Other Window Commands.
Window Cascade command Cascade windows in workspace.



Window Cascade command
The Window Cascade command cascades the active windows from top left to bottom right 
much like a paper stack.

Procedure:

1. Choose the Window Cascade command or press the F5 key to cascade windows.

Related Topics:
Window Commands Other Window Commands.
Window Tile command Tile windows in workspace.



Window Arrange Icons command
The Window Arrange Icons command arranges all icons in the workspace along the bottom 
of the workspace from left to right.

Procedure:

1. Choose the Window Arrange Icons command from the menu.

Related Topics:
Window Commands Other Window Commands.
Window Cascade command Cascade windows in workspace.
Window Tile command Tile windows in workspace.



Window Close All command
The Window Close All command closes all of the windows in the workspace after querying 
you to save any changes.

Procedure:

1. Choose the Window Close All command from the menu.
2. Answer Yes or No to the save question, or press Cancel to cancel this command .

Related Topics:
Window Commands Other Window Commands.
File Close command Close a single window.
File Exit command Close all windows and exit Money Smith.



Window 1,2,3... command
The Window 1,2,3... command makes the named window the active window and brings it to 
the top of the window stack, if any.

Procedure:

1. Select the window you want to activate from the Window 1,2,3... command list.

Related Topics:
Window Commands Other Window Commands.
Window Cascade command Cascade windows in workspace.
Window Tile command Tile windows in workspace.





Dialog Index
Dialog Descriptions:

Account Editing Dialog Account editing dialog.
Transaction Editing Dialog Transaction editing dialog.
Investment Editing Dialog Investment editing dialog.

Index:
Help Index Index of other topics.



Account Editing Dialog
The Account Editing Dialog lets you create and edit Money Smith accounts.    The minimum 
information to establish an account includes the Name, Type and Starting Balance.    Other 
fields may be filled in as desired to take advantage of advanced features.    See the Chapter 
on Setting Up Accounts for more information.

Description:

Name: A unique name that identified the account.    Examples: Checking, Savings, Food
Type: Either asset, liability, equity, income or expense.
Start Bal: The balance of the account when you started using Money Smith.
Budget: Your monthly budget for this income or expense.
Category: The category (if any) you want this account assigned to.
Taxes: Denotes whether this account is taxable or non-taxable.
Address/Phone: Location where this account is kept, if any.
Acct Num: Number the bank or financial institution gives to this account - for record 

keeping.
Investment: For stocks, mutual funds, investments - brings up the investment editor.    

See the Chapter on Investments for more information.
Another: This button saves this account and brings up a new account for adding.
Save: This button saves the current account.
Cancel: This button cancels all changes including any investment editing done. 

Related Topics:
Dialog Index Other Dialogs.
Edit Commands Editing commands.
Setting up Accounts Chapter Basics of setting up accounts.



Transaction Editing Dialog
The Transaction Editing Dialog lets you create and edit Money Smith transactions    The 
minimum information to establish a transaction include a date, description, amount, to 
account and from account.    See the Editing Transactions Chapter for detailed information.

Description:

Date: The transaction date in Month/Day/Year format.
Description: A description of the transaction or payee.    Example: Grocery Bill, Rent, 

etc...
Amount: Dollar amount of the transaction.
To: Account to move the money to.    You may type a name or select from the list.
From: Account to move the money from.    You may type a name or select from the list.
Cleared: Check this box if the transaction has cleared the bank or other institution.
Save: This button saves the current transaction.
Cancel: This button cancels all changes and cancels an Add transaction request.
Print: Prints the current transaction in check format.    This may force a setup of your 

printer if your printer is not currently set for 8-1/2" by 3-1/2" landscape checks.    See 
Printing Basics for more information on ordering and printing checks.

Recurring: Copies this transaction to a recurring transaction record and brings up the 
recurring transaction dialog described below.

The recurring transaction dialog:

The recurring transaction dialog has the same fields listed above plus two additional 
fields.    Recurring transactions are run with the period you specify until they are 
removed from the recurring transaction list for a given account file.    See the Chapter 
on Recurring Transactions and the Options Recurring command for more information.

Ask for confirmation checkbox: If marked, Money Smith displays the transaction for 
editing before it enters it when you open a file and the transaction frequency has 
passed.    Otherwise it is completely automatic.

Frequency: The frequency with which your transaction will run.

Related Topics:
Dialog Index Other Dialogs.
Options Recurring Transaction Commands Edit recurring transactions.
Editing Transaction Basics Basics on editing transactions.
Printing Basics Printing checks and other products.



Investment Editing Dialog
The Investment Editing Dialog lets you create and edit Money Smith investments.    The 
buttons on the right allow you to edit the investment history, while the list box and displays 
on the left show the current history record.    See the chapter on investment basics for more 
information. 

Display Description:

Account: Shows the current account name and account (not investment) balance.
Investment History: Shows a list of previous and current investment records by date 

and value. All information in the left column is based on the item highlighted in this 
listbox.

Transaction: Shows per transaction information as follows:
Description: A description of the current investment record.
Invest: Amount invested or taken for this transaction only.
Shares: Shares purchased for this transaction only.

Total Value: Shows the totals for all transactions up to and including this one as follows:
Value: Total dollar value of the investment.
Shares:    Total of shares owned as of this record date date.
Price: Price of investment as of this record date.

Net Gain: Shows performance totals as of this date (commissions not included).
Value: Gain in value (Total value as of this date minus amount invested).
Percent:    Strictly Total value as of record date over total amount invested.

Controls for the investment dialog:

Add: Adds a new investment history record to the list.
Edit: Edits the currently highlighted investment history record.
Delete: Deletes the highlighted investment history record.
Quit: Quits the investment editing dialog, saving all records.
Remove: Completely wipes out all investment records and deleted investment history 

for this account.
Reminder: Allows you to enter an investment record in similar fashion to recurring 

transactions.    You will automatically be reminded to enter these investment records 
when the specified period has passed and you open this account file.    Great for 
monthly investments!

Auto Tx: If checked, automatically generates real account transactions that mirror the 
investment history transactions and displays them every time you add an investment 
transaction either using the Add button or Reminder feature above.    This allows your 
account balance to match your amount invested as you add money to an investment.

Related Topics:
Dialog Index Other Dialogs.
Account Editing Dialog Account editing dialog.
Options Investments Commands Edit investments.
Investment Basics A full description of investments.
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1. Introduction to Money Smith
Why use Money Smith?
Why use    a tool like Money Smith?      You may not need it?    If you are already financially 
secure, are not worried about where your money is coming from or going to, and not 
interested in establishing a budget or tracking investments there is no reason to use this 
product.    Unfortunately, the rest of us do need a tool like Money Smith to help us better 
manage our Money and make financial decisions.

About Money Smith
Money Smith is a full featured tool for financial management.    It is scaleable.    You are not 
forced to use features you don't want to use.    If you don't want a budget, don't establish 
one.    If you don't care about account categories, don't use them.    If you'd rather track your 
investments using a spreadsheet, then you are not forced to enter them here.    We designed
it to be simple, but we have the features to satisfy the more demanding users.    

My advice: start small and learn the advanced features as you go.    The key is to start and 
start soon.    If you start now, you'll have a base of information to make decisions from.    If 
you start later, you'll continue to make many of your decisions blindly.

License
Money Smith is marketed as Shareware, but it is not free.    You are given a 30 day trial 
period to decide if you want to purchase the software.    The full license is contained in the 
license help selection.      Basically it says we're not responsible for any damages whatsoever 
that result from using this product, and that you agree to register the product if you use it 
outside of the 30 day trial period.    The Association of Shareware Professionals Ombudsman 
statement is at the end of the license.    They mediate problems between us and the public.   
They do not provide technical support.

Definition of Shareware
Shareware distribution gives users a chance to try software before buying it. If you try a 
Shareware program and continue using it, you are expected to register. Individual programs 
differ on details -- some request registration while others require it, some specify a 
maximum trial period. With registration, you get the simple right to continue using the 
software and an updated program.

Copyright laws apply to both Shareware and commercial software, and the copyright holder 
retains all rights, with a few specific exceptions as stated below. Shareware authors are 
accomplished programmers, just like commercial authors, and the programs are of 
comparable quality. (In both cases, there are good programs and bad ones!) The main 
difference is in the method of distribution. The author specifically grants the right to copy 
and distribute the software, either to all and sundry or to a specific group. For example, 
some authors require written permission before a commercial disk vendor may copy their 
Shareware.

Shareware is a distribution method, not a type of software. You should find software that 
suits your needs and pocketbook, whether it's commercial or Shareware. The Shareware 
system makes fitting your needs easier, because you can try before you buy. And because 
the overhead is low, prices are low also. Shareware has the ultimate money-back guarantee 
-- if you don't use the product, you don't pay for it.

Registering
We're not going to do any arm twisting about registering.    We distribute full working copies 
of Money Smith with the understanding that you are a responsible person who recognizes a 
software value.      The only difference between the version you have in your hands and the 



registered version is the annoying reminder dialogs that come up when you start Money 
Smith.    Registering gets rid of those and also gets you the very latest version, not to 
mention heavy discounts on upgrades.    To register, print the 'register.txt' file to the printer 
either from the windows notepad utility or using the DOS PRINT command.      Fill out the 
form and send it in with payment.

Benefits of Registration:
 - A disk (720k or 360k) including the latest version of Money Smith with documentation & 
examples.
 - A coupon for a free upgrade to the next version if you postmark your order before Dec 31, 
1992.    
    ---> Two versions for the price of one!
 - A 90 day limited warranty with mail support. (see license for details).
 - All of the annoying reminder dialogs are removed.
 - Notification and nice discounts for later versions.

HELP!
Money Smith has comprehensive help features including this entire manual online.    Our 
original point and press '?' (question mark) icon on the toolbar changes the mouse cursor 
into an arrow with a question mark.    Press the menu selection or item you want help on and 
it magically appears.    The same can be done with the Shift+F1 key.    You can also press F1 
anywhere (including dialogs) to get context sensitive help.    You won't find these features in 
just any piece of shareware!

Related Topics:
Money Smith Manual Manual for Money Smith.
Setting up Money Smith How to load, enter, and exit Money Smith.



2. Setting up Money Smith
From Registered Disks: Running Setup
If you took the plunge and registered Money Smith, you will have a program 
on the distribution disk called "setup.exe" which will create a directory of 
your choice on your hard drive and step through copying the files to your 
disk.    Just run this program from the program manager using the File Run 
command.    When setup is started it will ask for the source device (usually 
A:\ or B:\) and a destination directory (C:\SMITH is the default).    If you are 
installing from or to some other directory, type the paths in these two fields.  
The defaults are good for most people.

Setup will copy all the files to the directory specified and then set the 
executable up in your program manager in a group called 'Money Smith'.    
You can copy or move the icon to another program group using the program 
manager if you please.    If files are packed (360k disks for example) Setup 
will automatically unpack and remove the self extracting archive 
(smitharc.exe).

From the shareware source:
Odds are pretty good you downloaded this from a bulletin board or copied it 
from a buddy.    Odds are equally good the program is compacted in some 
way.    The most popular file compaction programs follow:

Self Extracting Archive example: smithpak.exe - you need to run
smith.exe

PKZIP format: example: smith.zip - you need to run 
pkunzip smith.zip

PKARC format: example smith.arc - you need to run
pkunpak smith.arc

LHARC format: example smith.lzh - you need to run
lharc x smith.lzh

You can get all three of these shareware unpacking program from you 
nearest bulletin board or a local users group.    Other packing programs are 
popular, so ask the person you got the program from what to use.    Use the 
setup program described above to install from floppy or hard drive after you 
unpack the files.

The Setup Destination Directory
Because Money Smith is large and you might eventually have several files 
packed in you will probably want a unique directory to put it in.    It can be 
anywhere on your hard disk you have enough space.    The setup.exe 



program will let you choose a directory and copy the files to it.    Fill in the 
destination directory edit box under the setup program.    The default is c:\
smith.

Starting Money Smith:
Double click the Money Smith icon after setting it up using the setup 
program.      Another method is selecting the 'Run' command from the 
program manager menu and typing the path to Money Smith.

Licensing Window:
Aside from the annoying dialogs, Money Smith will bring up a licensing window the first time 
you run it.    This window lets you type in your name and read the license.      For registered 
users, enter the registration number off of your registered disk.    If you agree to the license 
terms, choose I agree and continue.    If you have problems with the terms you can disagree 
and it will exit the program.    You only need to do this once.

Exiting Money Smith:
To exit you can double click the Money Smith system menu box, or choose the System Close 
command from the system menu box or choose the File Exit Command. 

Related Topics:
Money Smith Manual Manual for Money Smith.
Money Smith files How to open, close and backup Money Smith files.



3. Money Smith Files
All Money Smith data for a particular set of accounts is stored in one single file with a ".ACT" 
extension.    You might keep one Money Smith file for all of your home accounts and another 
for a small business.    You can name Money Smith files any way you choose as long as you 
keep the ".ACT" extension.

For the Beginner:
The easiest way to establish accounts is to use one of the sample Money Smith ".ACT" files 
distributed with Money Smith.    Just open a file (HOME.ACT is a good starting point) using the
File Open command and edit the accounts to reflect your own starting balances and 
budgets.    

Creating a new Money Smith File:
Creating an empty Money Smith file is easy.    Just choose the File New command from the 
menu, and add accounts and transactions as you please.    Be sure to save the file when you 
Exit from Money Smith or your work will be lost.

Saving a Money Smith File:
Choose the File Save command from the menu, or press the F3 key to save the currently 
active Money Smith file.    If you have not given this file a name, you will be prompted to type
one now.    You don't need to type the ".ACT" file extension since it is assumed.    If you have 
the Status Bar on, you should see the name and size of the file on the status bar after saving
it.

Opening an existing File:
Choose the File Open command, or select the file from the numbered list at the bottom of 
the File menu.      The name and size of the file will appear on the Status Bar after the file has
been opened.    Only transactions for the current month will be visible in the transaction 
views.

Passwords:
Money Smith has a password feature to prevent unauthorized people from looking at your 
private files.    You can enable this feature on any file using the Options Set Password 
command.    Just type in a new password twice (so they match) and it is set.    Anyone 
attempting to open the file will be asked the password.    If they put the wrong password in, 
they can't open it.    Don't forget your password, or you won't be able to open it either!

Copying, Backing Up, and Saving as another name:
To copy, backup, or save your file to another file, just open the file as described above then 
choose the File Save As command.    Select or type in the directory desired, then type in the 
new file name.    Press the OK button to save the file, or the Cancel button to cancel the 
save.      

Related Topics:
Money Smith Manual Manual for Money Smith.
Setting up your Accounts Setting up Money Smith Accounts.



4. Setting up your Accounts
Everything you want to track using Money Smith should be an account.    Accounts represent 
actual accounts or property (called assets),    real loans, leins or liabilities, your net worth 
which in Money Smith is called equity, and your income and expenses.    A real key to 
tracking your finances is setting up a good set of accounts.    If you have too many, your 
decisions will be clouded by a bunch of trivial data.    If you have too few, you won't be able 
to track what's really going on.    In general its best to start with a few accounts and grow as 
you go.      You can make up new accounts while typing transactions by just typing in an 
account name that does not exist, so there is no reason to knock yourself out with accounts 
to start.

Account View:
It's easiest to work on accounts from the account view.    Choose the View Account command
or press the 'Accts' button on the toolbar to view accounts.    Account View shows a list of all 
of your accounts listed alphabetically by type, with their starting and ending balances.

For the Beginner:
The easiest way to establish accounts is to use one of the sample Money Smith ".ACT" files 
distributed with Money Smith.    Just open a file (HOME.ACT is a good starting point) using the
File Open command and edit the accounts to reflect your own starting balances and 
budgets.    Delete the ones you don't need and add others as you go. 

Adding Accounts:
To add an account choose the Edit Add command or press the '+' toolbar button next to the 
'Accts' button.    Fill the account dialog as described below.

Filling the Account Dialog
At a minimum, fill in the Name, Type and Starting Balance or Budget fields in the Account 
Dialog.    Use the tab key to move from field to field.    Other fields are optional and can be 
filled later.    The name is any unique account name like 'Checking' or 'Savings'.    The type is  
assets,    liability, equity(net worth), income or expense.The starting balance represents the 
account balance at the beginning of the month you start using Money Smith.    The budget is 
a monthly expected income or expense for the account. Press return to save the account 
and bring up another.    Press the Cancel button to stop adding accounts.

Editing Accounts:
You've entered your accounts, but messed up a few.    Select the offending account by 
pushing it with the mouse or using the arrow keys to highlight it while still in account view.    
Choose the Edit Edit command or press the '*' toolbar button next to the 'Accts' button.    
Double clicking the account or pressing the Enter key from account view also works.    Any of 
these will bring up the Account Dialog.    Use the tab key or mouse to move to the field you 
want to change and either type or select the new value.    Press 'Save' or the Enter key to 
save your changes.    Press the cancel key to skip your changes.

Deleting Accounts:
You have an account that's no longer needed, or maybe you're just deleting an account from
one of our examples.    Before you can delete an account, you must make sure there are no 
transactions against it.      If there are, Money Smith will tell you.    Select the account you 
want to delete from account view using the mouse or arrow keys then choose the Edit 
Delete command or the Edit Cut command or press the '-' (minus) button next to the 'Acct' 
button on the toolbar.    

Money Smith will prompt you to make sure you want it deleted.    If you still have 
transactions assigned to the account, Money Smith won't delete the account.    To find these 



transactions you can select the account and switch to 'Register' view by choosing the View 
Register command or pressing the 'Register' button on the toolbar.    You may need to 
change the date to view all transactions since by default Money Smith shows only the 
current month.    Delete or edit these transactions and assign them to another account.

Limitations:
You are currently limited to 200 accounts in a single Money Smith file.

Related Topics:
Money Smith Manual Manual for Money Smith.
Editing Transactions How to enter, edit, and delete Money Smith transactions.



5. Entering Transactions
Any flow of money from one account to another is called a transaction.      You can find the 
most obvious examples of transactions by opening your checkbook.    When you write a 
check to pay your electric bill you are creating a transaction from your checkbook account to
your 'Electric' expense account.    When you make a credit card purchase, you create a 
transaction from your    'Mastercard' account to the appropriate 'Expense' account.    When 
you pay off that Credit Card you create a transaction from your 'Checking' account to your 
'Mastercard' account.

Thinking Transactions:
It takes a while to think in terms of transactions.    The two primary questions are:

 'Where's the money coming from?'            and 
'Where's the money going to?'

If you have both of these you are ready to enter transactions. 

Transaction and Register View:
Money Smith has two ways to look at transactions.      You probably want to be in one of 
these views when editing transactions.      Transaction view shows you all of your transactions
for the current month.    You can get to transaction view using the View Transaction 
command or by pressing the 'Txact' button on the toolbar.    Register view shows the 
transactions for only the current account (Checking for example).    This view is great if 
you're working from just one account.    To get to register view you first need to set the 
current account to the one you want from the Account View.    Then choose the View Register
command or press the 'Register' button on the toolbar.

Dates:
The current dates determine which transactions are viewable and what account balances 
you see.    By default Money Smith sets the accounting dates to reflect the current month.    If
you want to see another month or several months you need to use the View Date command 
to change the current dates.

Adding Transactions:
To add transactions, make sure you are either in Transaction or Register view and then 
choose the Edit Add command or press the '+' (plus) button next to the 'Txact' button on the
toolbar.    

Filling the Transaction Dialog:
To fill the transaction dialog, first enter the date and check number (if any) of the 
transaction.    Next enter the payee (for a check) or description of the transaction.    The 
amount in dollars goes in the next field.    Finally you can put in the To and From accounts by 
either typing the name or selecting them from the Combo Box.    The cleared checkbox is 
used to help reconcile your account and is usually checked once the transaction has cleared 
the bank.    Press 'Another' or the Enter key to save this transaction and bring up another.      
Press Save or Cancel to stop adding transactions.

Making up Accounts on the fly:
A powerful feature of Money Smith is that it allows you to make up new accounts while 
entering transactions.    Suppose you have a new bill or expense that didn't exist before.    
While in the transaction editor you just need to type in the new account name in either the 
'To' or 'From' field.    When you try to save this transaction Money Smith will ask you if you 
want to add the new account and bring up the Account Editing Dialog to let you add it.    All 
without skipping a beat.

Recurring Transactions on the Fly:



Money Smith lets you automate repetitive bills and transactions using recurring transactions.
Pressing the 'Recurring' button lets you do this.    The topic is fully covered in the chapter on 
Recurring Transactions.

Editing Transactions:
From either transaction or register view select the transaction you want to change with the 
arrow keys or mouse.    Choose the Edit Edit command or press the Enter key to bring up the 
transaction dialog.      Double clicking the transaction or pressing the '*' (star) button next to 
the 'Txact' button on the toolbar also works.    Use the tab key or mouse to move to the field 
you want to make changes on and press the Enter key or Save to save your changes.

Deleting Transactions:
From transaction or register view, select the transaction you want to delete using the mouse 
or arrow keys.    Choose the Edit Delete command or the Edit Cut command or press the '-' 
(minus) button next to the 'Txact' button on the toolbar.    Confirm your deletion by pressing 
'Yes'.    All your account balances are updated automatically.

Printing Transactions:
You can print transactions from any of the transaction views using the File Print command.    
You can also print checks if you have a capable printer and tractor fed business checks of 
the right type.    See the chapter on Printing for more information.

Limitations:
The number of transactions is limited by the amount of memory Windows can allocate and a 
program limitation.    Each transaction takes approximately 64 bytes and Money Smith places
a limitation of 32,767 transactions itself.

Related Topics:
Money Smith Manual Manual for Money Smith.
Money Smith reports Creating and printing reports.



6. Money Smith Reports
Automatic Reports
Now that you have entered tons of financial trivia, what do you do with it?    A great starting 
point is to print a few reports.    Reports tell you lots of interesting things like where your 
money is coming from and going to.    They tell you your net worth.    They help you balance 
your checkbook.      Lets look at some Money Smith reports.

Using Reports:
You create a report window using one of the commands under the Report Menu.    Report 
windows are documents of their very own.      The great thing about this is that they update 
automatically.    If you add a transaction or change a balance the report changes magically.    
You don't need to recreate it.    You can maximize your report, minimize them to an icon,    tile
them to appear side by side, and do just about anything you want to them.    They even have
their own menu of commands for printing, copying, saving to a text file, etc...    Two 
important commands to know are the File Close command and the Window 1,2,3 command 
since these let you exit the report or just switch back to your Money Smith account window.

Setting the Report/Graph Title
Use the Options Report Title command to change the title that appears at the top of all 
reports and graphs.

The Balance (Net Worth) Statement:    Report Balance Statement command
The balance statement gives you a snapshot of your current value or net worth.    It shows 
you all your Assets (Great), all of your Liabilities (Not so great!)    and your Equity (Net 
Worth).    The percentages are nice because they show you where your money is really tied 
up.    Equity is interesting because it shows both your starting equity (The sum of all of your 
starting balances) from when you started using Money Smith, and your retained earnings a 
fancy word for how much money you've earned and kept in one form or another since 
starting to use Money Smith.

The Income (Cash Flow) Statement:    Report Income Statement command
The Income Statement shows you totals of all of your income accounts and expense 
accounts for the current dates.      Percentages show you where your money is coming from 
and going to.    You'll probably be surprised by some of the expense percentages.    The 
bottom line on this statement is your net income which represents all your income minus all 
your expenses.    If this is a positive value you are in good shape.    If it's negative, you may 
be in trouble since you are spending more dollars than you are taking in.    Take a hard look 
at your expenses (the Graph Expense command might help) and your budget report (below) 
to try to get spending under control.    Decide what you can do without and stick to it.

The Budget Report:    Report Budget Report command
The budget report helps you compare your monthly budget against actual spending.    It 
shows the difference between the budget you set for each income or expense account and 
the amount you actually spent.    The difference is shown both in dollars and as a percent.    
By tightly monitoring this report and modifying your budget to better reflect reality you may 
be able to bring up that Net Income figure from the Income Report and live a little more 
financially secure.

The Tax Summary Report:    Report Tax Summary command
If you have been vigilant all year long and entered data for a whole year, this report might 
help you fill out the old 1040 form.    Basically it just totals the income and expense accounts
you marked as Taxable or Non-taxable and prints the totals out.    This might help remind you
of the $10 bucks you gave to charity,    or $100 you earned on that stock that you forgot 
about.    Money Smith will not do your taxes, however.    It won't even attempt to estimate 



your taxes since tax laws change annually and I'm just not ready for that kind of litigation.    
Several commercial programs are out for this purpose although a discount tax preparer 
probably costs no more than the software.    You don't need to teach yourself how to use a 
tax preparer either!

The Reconcile Account Report:    Report Reconcile Current Account command
The monthly checking statement comes in and as usual it doesn't match.    You bring up 
Money Smith and switch to the Register view for your checking account.    You patiently walk 
through and mark all of the cleared transactions using the transaction editor.    What now?    
Bring up the reconcile current account report.    It shows where your account balance differs 
from your cleared balance.    What's better its a Money Smith report, so you can tile it side by
side with your transactions using the Window Tile Command (F4 key)    As you clear and edit 
your transactions, the report changes to reflect new balances automatically.    In a few 
minutes you can balance your checkbook using Money Smith.

The Category Report:    Report Category Report command
Categories are better covered in the chapter on Account Categories.      Basically a category 
is a collection of accounts you want to group together.    It may be an investment portfolio, 
consumer debt, your entertainment expense accounts, or just about anything.    This report 
shows you the current balances of all the accounts in your categories and totals them for 
you.    Percentages let you see how much single accounts affect the category balance.    This 
is a nice advanced account feature.

The Investment Report:    Report Investment Summary command
Investments are better covered in the chapter on Investments.      Basically an investment is 
a special account with investment transactions kept on it.    This lets you track the value of a 
stock or mutual fund easily without messing up the nice neat double entry accounting 
system that Money Smith uses for regular balances.    The investment report shows all your 
investment transactions and the current values and return on all your investments.

Limitations:
You can only have a total of 10 combined report and graph windows active on a single 
Money Smith file.    This is not a problem for most users.

Related Topics:
Money Smith Manual Manual for Money Smith.
Money Smith Graphs Creating and printing graphs.



7. Money Smith Graphs
Automatic Graphs
Another great way to look at your finances is using Money Smith graphs.    Graphs often let 
you see things that are not so obvious in the numbers.      Money Smith creates graph 
windows that get automatically updated as the underlying data changes just like Money 
Smith reports

Using Graphs:
You create a graph window using one of the commands under the Graph Menu.    Graph 
windows are documents of their very own.      The great thing about this is that they update 
automatically.    If you add a transaction or change a balance the graph changes magically.    
You don't need to recreate it.    You can maximize your graph, minimize them to an icon,    tile
them to appear side by side, and do just about anything you want to them.    They even have
their own menu of commands for printing, copying, saving to a text file, etc...    Two 
important commands to know are the File Close command and the Window 1,2,3 command 
since these let you exit the graph or just switch back to your Money Smith account window.   
You can copy your graph to the clipboard and read it into any graphical program like paint.

Setting the Report/Graph Title
Use the Options Report Title command to change the title that appears at the top of all 
reports and graphs.

The Assets Graph:    Graph Assets command
The Liability Graph:    Graph Liability command
The Equity Graph:    Graph Equity command
The Income Graph:    Graph Income command
The Expense Graph:    Graph Expense command
All of these graphs display a pie graph of accounts of the given type, either assets,    liability,
equity(net worth), income or expense. It's important to note that only accounts with positive 
balances are graphed.    I don't have an easy method for graphing negative pie slices.

The Category Graph:    Graph Category command
The category graph lets you select a category from your list or categories and the shows the
category composition in a pie graph.    This is great for seeing how an investment portfolio is 
diversified, for example.

The Current Investment Graph:    Graph Current Investment command
The    graph current investment command lets you see bar graphs of the price, value or 
return history for a selected investment account.    Just make sure you select the account you
want to graph from account view first or you'll get an error when you try to graph a non-
investment.    The bar graphs show all of your investment history and might help in deciding 
what to do with a stock or mutual fund.      Note: Returns are calculated as total value over 
total investment and are not annualized or otherwise convoluted, so you need to be careful 
when making decisions based on these values. 

Limitations:
You can only have a total of 10 combined report and graph windows active on a single 
Money Smith file.    This is not a problem for most users.

Related Topics:
Money Smith Manual Manual for Money Smith.
Printing Manual Printing graphs, reports, views and checks.



8. Printing Basics
What can I print?

You can print any graph, report, or view.    If you have the right printer and order some 
checks as described below, you can also print checks using Money Smith. 

Printing: General Tips:
Make sure your printer is properly setup before using it.    For graphs, reports and views, 
the File Print command prints the currently active window.    A printing dialog shows the 
current document and page.    You can press the Cancel button on the print dialog to 
cancel a print in progress or use the Windows Print Manager.

Printing Views:
Printing any Money Smith view is easy.    Select the view you want to print and choose the
File Print command.    Your current view, either account, transaction, or register, will be 
printed on the printer.    You can toggle the Grid lines off of the view using the View Grid 
command to speed printing if you like.    Most printers print slowed when printing the 
Grid.

Printing Reports:
Printing a report is also very easy.    Create the report    you want to print using the Report
Commands or activate a previously created report window.    Choose the File Print 
command to print the report.    Make sure you have a fixed pitch font selected for the 
printer or your columns may not line up properly.

Printing Graphs:
You first need to create a graph using the Graph Commands, or activate a previous graph
by pressing it with the mouse.    You can use two methods to print a graph.    One is to 
print using the File Print command.    This produces a full page graph.    If you want a 
smaller graph or want to import the graph somewhere you can use the Edit Copy 
command to copy the graph to the clipboard and import it into Windows Write, 
Paintbrush or a like application and print it from there.

Ordering Checks:
Before you can print any checks, you need to order some.    Before ordering some, I 
recommend you perform a little test to make sure your printer will support check size 
paper.    Money Smith supports general purpose tracter fed Business size checks of 8-1/2"
by 3-1/2" size and prints them in Landscape mode.    If your Windows printer driver does 
not support 8-1/2" by 3-1/2" paper size in Landscape mode, odds are the checks won't 
work.    You can check this using the Printer Setup command, pressing the Setup button, 
and looking at the list of paper sizes.    You can also choose the Print button from the 
Transaction Dialog which will force you to set your printer paper size if not set correctly.    
You can try a few on plain paper before you order.

Money Smith has been tested with the following check styles: 091013 and 091004 from:
Deluxe Business and Computer Forms
3660 Victoria Street North
P.O. Box 64046
St. Paul, MN 54164-0046
1-800-328-0304

They are quite nice people and will be happy to send you a catalog.    Money Smith will 
likely work with most of the Dual Purpose (one check and one blank page with check 
number for records) checks with a little vertical adjustment.    They are not the only ones 
that print checks, they just happened to be the ones I got my samples from.    Many other



reputable companies make checks that work, just use discretion and common sense 
before sinking a bundle in custom printed checks.

Printing Checks:
Checks are printed directly from your transactions.    First make sure your printer is set up
with the checks in it, form size set to 8-1/2" wide by 3-1/2" high landscape mode.    Next 
bring up the transaction dialog to enter or edit a check and press the Print button.    If 
your paper size is wrong, Money Smith will let you change it from here.    Otherwise your 
check should be printed twice, once on the check and once on the receipt page.    The 
transaction 'Description' field willbe printed on the 'Pay to the Order of' line.    The To 
account address, if any, will be printed below that, and the transaction date and amount 
will be printed in the appropriate columns.    You may need to adjust your printer 
allignment to match the checks exactly.

Be sure to adjust your printer page size back to the original when you change from 
checks back to paper on your printer.

Related Topics:
Money Smith Manual Manual for Money Smith.
Recurring Transactions Automate your regular bills.



9. Recurring Transactions
What's a recurring transaction?
Another great feature of Money Smith is the ability to automate transactions so you don't go 
crazy every month entering transactions.    These are called recurring transactions.    A 
recurring transaction is a transaction that happens with some regular frequency.    A 
checkbox lets you either totally automate the transaction so you don't even know it was 
added or else have Money Smith bring the transaction up when you open the file so you can 
edit it or cancel it.    Don't use recurring transactions for investments.    The investment 
chapter describes an investment reminder service that is better for this purpose.

Creating Recurring Transactions the easy way:
The easy way to create a recurring transaction is to bring up an existing transaction for 
editing using the Edit Edit command from transaction or register view.    Then press the 
'Recurring' button in the transaction dialog to bring up the recurring transaction dialog.

Filling the Recurring Transaction Dialog:
Fill in the dialog as you normally would any .    The date is the starting date of the transaction
which should be sometime in the future.    Check or uncheck the 'Confirm...'    checkbox 
depending on if you want to confirm this transaction or have it be fully automatic.    
Generally if a transaction is the same amount each month and you're not interested in 
putting a check number in, make it fully automatic.    Otherwise make sure you have the 
Confirm box checked.    Check the frequency as appropriate.    Press Save to save or Cancel 
to cancel this addition.

Editing Recurring Transactions:
The Options Recurring Transactions command and 'Recur' button on the toolbar both bring 
up a list of recurring transactions and let you add to, edit, or delete from the list.    The basic 
procedure is to select the transaction you want to work with from the list box,    then press 
the 'Add', 'Edit' or 'Delete' button to bring up the transaction editor or a delete confirmation. 
The run button forces an out of cycle transaction to be created but does nothing to the 
regular schedule of recurring transactions.    The 'Quit' button leaves the recurring 
transaction editor.

Running Recurring Transactions:
To normally run recurring transactions you don't do anything.    It automatically happens 
when you open the file.    Just make sure your system clock is set right before you run Money 
Smith.    You can force an out of cycle recurring transaction by pressing the 'Run' button from
the recurring transaction editor described in the previous paragraph.    

Limitations:
Money Smith has a limitation of 40 recurring transactions active on one Money Smith file.    
This is not a problem for most home users.

Related Topics:
Money Smith Manual Manual for Money Smith.
Setting up Categories Setting up account categories.



10. Defining Account Categories
What's an Account Category?
An account category is nothing more than a group of accounts you want to occasionally see 
together.    Examples include investment portfolios, your IRA accounts,    and expense 
groupings like living expenses, entertainment expenses and the like.    The Report Category 
command and Graph Category command let you analyze these categories once you set 
them up.

Creating Categories the Easy Way (on the fly):
The easy way to create categories is to assign them as you build or edit your accounts.    
From account view select an account you want in the category and edit it by double clicking 
it with the mouse or pressing the Enter key.      This will bring up the Account Dialog which 
has a field called 'Category' which by default has a value of '(None)'.    Use the tab key or 
mouse to move the cursor there and type in the name of your new category.    Press the 
Enter key or the Save button to save the transaction and Money Smith will ask if you want to
add this new category.    Press Yes.    Now you can edit the other accounts you want in your 
category, but now you can use the drop down list of categories to select the newly added 
category rather than typing it.

Editing Categories:
You can add, edit, and delete categories using the Options Category command.    The basic 
process is to select the category you want to act on then press the 'Add', 'Edit' or 'Delete' 
button.    It is important to note that you will get an error if you delete a category with 
accounts defined in it.

Limitations:
Currently an account can only be assigned to one category at a time.    You can only have 30 
categories defined for one Money Smith file.

Related Topics:
Money Smith Manual Manual for Money Smith.
Investment accounts Handle stocks, mutual funds, and the like.



11. Investment Accounts
What's an Investment Account?
An investment account is a normal Money Smith account with an added investment history.   
The investment history records keeps track of the price, value, and money invested in a 
security like a stock or mutual fund.    The reason for keeping it separate from regular 
account balances and transactions is to maintain the sanity of the standard double entry 
accounting system used by Money Smith.    Automatic transaction features help you to keep 
your investment balance and account balance in sync.    The advantage of an investment 
account is it helps you track the value of your investments without destroying the simplicity 
of a standard cost accounting system.
 
Establishing an Investment Account:
Some small investment examples are included in the sample account files with Money 
Smith.    To add your own create an account as you normally would, then edit it by double 
clicking the account or pressing the Enter key on it in account view.    From the Account 
Editing Dialog, press the Investment button to bring up the Investment Editing Dialog.    
Press the 'Add' button to add a new investment transaction.    

Filling in an Investment History Record
Put a description, dollar amount invested, and price in for the security.    The number of 
shares are computed from the dollar amount and price.    When you save your record, a 
corresponding regular transaction will be displayed with the same information to update the 
underlying account with the new investment.    Fill this in and save if you wish.    This double 
entry system maintains the balance of the underlying account without having its value 
fluctuate with the price of the security.    This feature is enabled and disabled using the 
'AutoTx' button in the Investment editing dialog.

Editing History Records:
You can add as many as you like.    I usually pull out my most recent mutual fund statement 
and enter the monthly information from it, pressing the 'Add' button for each.    To change or 
delete a history record, select it from the list box in the center of the Investment Editing 
Dialog and press the 'Edit' or 'Delete' buttons.    Press 'Quit' when you are done with this 
investment.

Viewing History Records:
To view past performance all you need to do is select the corresponding record in the list 
box.    This brings up all of the investment, price, value, and performance information around
it described in the Investment Editing Dialog documentation.    You can also see these 
records in other ways using the Graph Current Investment command and Report Investment 
Summary command.

Removing Investments from an Account:
You can remove all investment history from an account by pressing the 'Remove' button in 
the Investment Editing dialog for a given account.    This wipes it out completely - so be 
careful.    It makes this account a normal one.

Another way to Edit Investments:
You can also access the Investment Editing Dialog using the Options Investment command.   
This command lists all accounts defined as investment accounts and lets you select and edit
them.

Investment Reminder Service:
The investment reminder service is analogous to recurring transactions for investment 
accounts.    The main difference is that the investment history record editor is always 



brought up for confirmation since it is assumed that you will always need to enter a new 
security price.    To set up the investment reminder press the 'Reminder' button on the 
Investment Editing Dialog.    Fill in the starting date,    history record amount and description, 
and the frequency for the reminder.    The from account indicates which account to transfer 
money from for regular transactions generated if the 'AutoTx' checkbox is enabled.    Press 
OK to enable the reminder or Cancel to cancel it.    Reminders will come up automatically 
when you open the file on or after the assigned date.

Limitations:
Money Smith keeps the last 20 investment history records and automatically rolls other into 
a starting investment balance for the investment.

Related Topics:
Money Smith Manual Manual for Money Smith.
Ending the Year Rolling out transactions at the end of the year.



12. End of Year Processing
Why roll transactions out?
You could go on indefinitely writing transactions against the same set of accounts, but I 
recommend you roll your accounts out at least once (sometimes more) a year.    Why?    For 
one thing, Money Smith has to walk through all the transactions to get a good balance when 
you load the accounts or change the dates.    After a while this process can get time 
consuming.    Besides Money Smith quickly becomes a memory pig when you start having 
files with thousands of transactions.    It's also good to make a fresh start each year because 
that's what the IRS wants from you. 

What really happens?
Aside from making a backup copy, Money Smith really just rolls the dollar amounts from all 
your transactions before the cutoff date into the respective account balances.    It then 
deletes those transactions.    The result:    You have the same asset, liability, and equity 
account balances but no more transactions.    You start the year fresh.

Running the End of Year Process:
Select the Options End of Year command from the menu.    If you want a closeout date other 
than the one shown, press yes and enter another closeout (ending) date.    Next press yes if 
you want your investment history records rolled out with the regular transactions.    
Otherwise, your investment histories of any investment accounts will remain intact.    Next if 
you want a backup copy (highly recommended) press yes and enter a new name like 
'HOME92' to save a backup of this file.    If you choose to backup, you will also be prompted 
on removing recurring transactions from the backup.    This is also highly recommended.    
Otherwise you will be hit with a flurry of recurring transactions when you later want to 
access your backup file.    Finally you get one more chance to bail out.    If you press Yes the 
work will be done and everything before the closeout will be rolled out.

Related Topics:
Money Smith Manual Manual for Money Smith.


